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Introduction

The example Stiffness Analysis of a Communication Mast’s Diagonal Mounting in the
COMSOL Multiphysics Application Libraries shows how you can modify a 3D CAD
model to improve its performance. In that case, the applied changes were based solely on
the analyst’s experience with similar structures. A senior design engineer can sometimes
reach acceptable performance after analyzing only a handful of designs, while an

inexperienced analyst may have to spend a lot of time on failed attempts.

Usually, you can indeed improve a design by trial and error, but it is difficult to ensure that
the price you pay — in this example, added weight and material costs — is as low as
possible. With sensitivity analysis, you can find the most cost-efficient direction for a small

modification and estimate the effect it has before attempting an updated design.

Model Definition

The original model simulates the deformation of a part of a communication mast, shown
in Figure 1, under loads in the linear regime. The ratio of the part’s effective stiffness to

the stiffness of an equal length of straight pipe is evaluated as a measure of'its performance.
Using sensitivity analysis together with a Deformed Geometry interface, you can predict
what effect changing the dimensions of the end plate and the mount plates has on the

part’s relative stiffness.
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Figure 1: Mounting detail of o mast diagonal.
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From the designer’s point of view, the material thickness of the end plate, £, and of the

mount plates, ¢, are the most relevant parameters because they are easy to change both
in the CAD system and on the production line. These quantities are, however, not directly
comparable to cach other because a unit change of ¢, incurs a different cost — added

weight and material use — compared to a unit change in ¢,.

For a fair analysis, it is therefore more convenient to parameterize the model in terms of
the masses Am, and Am,, added to the end plate and mount, respectively. The relation

between added mass, Am, and thickness change, AZ, is given by
Am = pAAt

where A is the area affected by the thickness change (m2) and p is the density of the
material (kg/ m3).

As output from a sensitivity analysis using the stiffness ratio, Sg, as objective function and

the differential masses Amp, and Amy, as sensitivity variables, you get the partial derivatives

om m T om,

Q) =

For a modified geometry corresponding to small values of Am, and Am, you can
therefore expect to see a change in the stitfhess ratio equal to

ASy = QpAmp +Q Am

Note that this relation holds only for a small incremental change from the current
configuration because the stiffness ratio is clearly a nonlinear function of the thicknesses.
Now suppose that you want to select the best possible design update for a given added
mass Am = Am, + Am, with the added condition that both Am, and Am, are
nonnegative. It is not too difficult to realize that the best option is to take Amp, = Am,
Amy, =0if @ > @y, and Am, =0, Amy, = Am otherwise.

The optimal stiffhess for a given total mass of the structure can be sought by relaxing the
nonnegativity condition for the updates and instead restricting the maximum change in

Amy, and Amy, during one iteration. With the total mass as only constraint, you find the
optimum design at a point where @, = @, This follows strictly from the Karush-Kuhn-
Tucker conditions but also from the simple fact that at such a point, the increased stiffness
from adding mass to the plate is exactly canceled by the decrease in stiffness from removing

the same mass from the mount.
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PARAMETERIZING THE GEOMETRY

In the Sensitivity interface, you declare sensitivity variables, which can be used to
parameterize the physics. The sensitivity variables can appear anywhere COMSOL
Multiphysics accepts an expression containing the dependent variables. However, neither
dependent variables nor sensitivity variables can be used directly to set dimensions in the

geometry.

To evaluate the sensitivity of a model with respect to geometrical changes, the geometry
must first be made an active part of the system of equations. You accomplish this by
moving all physics onto a deformed configuration controlled by a Deformed Geometry
interface, described in Deformed Geometry and Moving Mesh in the COMSOL
Multiphysics Reference Manual. This interface sets up an equation governing the position
of the mesh nodes inside the domains, while the outer shape of the domain is controlled

by boundary conditions.

When doing sensitivity analysis, these boundary conditions are quite simple: on fixed
surfaces, set the mesh displacement to zero; on surfaces that may be modified, specify the
displacement in terms of the sensitivity variables. In this particular case, where the material
thickness of the end plate and the mount can change, it is enough to set the normal
displacement of these surfaces equal to the thickness change calculated from the
corresponding added mass. For the latter calculation, assume the total undeformed length

of the part to be fixed and define Am,, as the net mass added when ¢, increases.

On surfaces adjacent to a domain with a parameterized normal displacement, it is

preferable to restrict the mesh displacement to zero only in the normal direction to avoid
an inconsistent constraint on the common edge. However, any remaining inconsistencies
do not invalidate your results completely but only effectively modify the parameterization.
In cases like this, when the purpose of the analysis is a rough estimate and guidance for a

manual redesign, such minor errors in the sensitivities are unimportant.

Another potential source of errors must be checked more carefully, though. Changing the
material thickness of the mount also changes the area where the loading is applied. In the
Solid Mechanics interface, you specify the load as a given force per area. If you keep this
number fixed when the thickness of the part changes, the total applied load also changes;
when evaluating the stiffness ratio of the composite part you must account for this effect.
Alternatively, you can keep the total force fixed and make sure that the applied force per
unit area is calculated using a hole area that follows the parameterization of the geometry.
This is simply done by changing the expression for the mount hole xy-projected area to

AV =21 (¢ +8E,)
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where 8%, is the increase in the mount thickness.

CHOOSING FORWARD OR ADJOINT SENSITIVITY ANALYSIS

By default, the Sensitivity interface uses the adjoint method, which is more efficient than
the forward method when the number of sensitivity variables is large. When there is only
a handful of scalar parameters, as in this case, the forward method has the advantage that
it returns the sensitivity of the entire solution with respect to the sensitivity variables in
addition to the sensitivity of the objective function. This additional information can
sometimes be important in itself, but more often it is useful for checking the model setup
because it is easy to visualize.

Results and Discussion

The analysis shows that when the thickness of the end plate is 12 mm and the material
thickness in the mount is 15 mm, the sensitivities to adding mass to the two details are
Qp = 0.25 and @y, = 0.23, respectively. Because, apparently, adding mass to the end plate
has more effect than adding it to the mount, the next redesign of the part should be fitted
with a thicker plate. You might even consider decreasing the material thickness of the

mount while adding to the plate to keep the weight of the part constant.

Note that these conclusions only hold for the current instance of the design. An
experienced analyst quickly realizes that the stiffness contribution of the plate is due to
bending action, while the stiffness contribution of the mount is almost pure tensile action.
A plate’s resistance to bending grows as its thickness cubed, while resistance to tension is
proportional to the cross-sectional area. Therefore, as the thickness of the plate increases,

its contribution to the stifthess of the composite part increases rapidly.

If you increase the thickness of the end plate too much, the stiffness of the mount takes
over as dominant factor in the overall behavior. Using sensitivity analysis, you can easily
detect when this happens, because it leads to @p, > @ As noted above, an optimum
design for a given total mass is found when @, = Q.

Because the sensitivity analysis was performed using the forward method, the derivatives
of the solution with respect to the parameters Am, and Am, have also been stored. You
can access this data when processing the results by using the syntax sens (expr, var). For
example, by plotting the expression sens (w,dm_p), you can directly examine the local

effect of a unit increase in the plate mass; see Figure 2.
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Surface: Sensitivity of w to added plate mass
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Figure 2: The influence of 1 mm mount thickness increase on the overall displacement.

Application Library path: COMSOL_Multiphysics/Structural_Mechanics/
mast_diagonal_mounting_sensitivity

Modeling Instructions

APPLICATION LIBRARIES

I From the File menu, choose Application Libraries.

2 In the Application Libraries window, select COMSOL Multiphysics>Structural Mechanics>
mast_diagonal_mounting in the tree.

3 Click Open.

ADD PHYSICS
I In the Home toolbar, click i Add Physics to open the Add Physics window.
2 Go to the Add Physics window.
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3 In the tree, select Mathematics>Deformed Mesh>Legacy Deformed Mesh>
Deformed Geometry (dg).

4 Find the Physics interfaces in study subsection. In the table, clear the Solve check box for
Study I.

5 Click Add to Component | in the window toolbar.

6 In the Home toolbar, click i Add Physics to close the Add Physics window.

ADD STUDY
I In the Home toolbar, click :\‘53 Add Study to open the Add Study window.

2 Go to the Add Study window.

3 Find the Studies subsection. In the Select Study tree, select General Studies>Stationary.
4 Click Add Study in the window toolbar.

5 In the Home toolbar, click "\‘ji Add Study to close the Add Study window.

GLOBAL DEFINITIONS
Modify the parameters for the plate thickness and mount thickness to correspond to the
updated configuration of the original model.

Parameters |
I In the Model Builder window, under Global Definitions click Parameters I.
2 In the Settings window for Parameters, locate the Parameters section.

3 In the table, modify the following settings:

Name Expression Value Description
t_p 12[mm] 0.012m Plate thickness
tm 15[mm] 0.015m Mount thickness

4 Next, define the masses added to the plate and mount that you will use later as global

control variables.

Name Expression Value Description

dm_p 0 0 Added mass, plate
dm_m 0 0 Added mass, mount
DEFINITIONS

Create a selection for the domains where the mesh will be allowed to deform.
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Deformed mesh domains )
I In the Definitions toolbar, click @l. Union.

In the Settings window for Unien, locate the Input Entities section.

Under Selections to add, click - Add.

2
3
4 In the Add dialog box, in the Selections to add list, choose End plate and Mount.
5 Click OK.

6 In the Settings window for Union, type Deformed mesh domains in the Label text field.
7

Click the @ Wireframe Rendering button in the Graphics toolbar.
Outer mount faces
I In the Definitions toolbar, click (//0 Nonlocal Couplings and choose Integration.

Add component couplings for integrating over the flat surfaces of the plate and mount.
2 In the Settings window for Integration, type dA_mt in the Operator name text field.

3 Locate the Source Selection section. From the Geometric entity level list, choose
Boundary.

4 Select Boundaries 15 and 56 only.

50 mm

5 Click " Create Selection.
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6 In the Create Selection dialog box, type Outer mount faces in the Selection name text
field.

7 Click OK.
8 In the Settings window for Integration, type Outer mount faces in the Label text field.

Plate surface

I In the Definitions toolbar, click (//// Nonlocal Couplings and choose Integration.

2 In the Settings window for Integration, type dA_pl in the Operator name text ficld.

3 Locate the Source Selection section. From the Geometric entity level list, choose
Boundary.

4 Select Boundary 4 only.

<

y\T/'x

5 Click " Create Selection.

6 In the Create Selection dialog box, type Plate surface in the Selection name text field.
7 Click OK.

8 In the Settings window for Integration, type Plate surface in the Label text field.

9 Click the @ Wireframe Rendering button in the Graphics toolbar to return to the
default state.

Next, define variables for the displacements as functions of the added masses.
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Sensitivity Variables
I In the Definitions toolbar, click &= Local Variables.

2 In the Settings window for Variables, locate the Variables section.

3 In the table, enter the following settings:

Name Expression Unit Description

mA_pl dA_pl(solid.rho) kg/m Mass per unit thickness,
plate

mA_mt dA_mt(solid.rho) kg/m Mass per unit thickness,
mount

dt_p dm_p[kg]/mA_pl m Displacement, plate end
face

dt m dm_m[kg]/mA_mt m Displacement, outer

mount faces

The mass per unit thickness for the plate refers to the area outside the surface where the
plate connects to the mount; thus, it gives the net added mass when the thickness of the

plate increases.
4 In the Label text field, type Sensitivity Variables.
Variables |
Modify the variables that are affected by change in plate and mount thickness.
I In the Model Builder window, click Variables 1.
2 In the Settings window for Variables, locate the Variables section.

3 In the table, modify the following settings:

Name Expression Unit Description
Axy_mh 2*r_mh* (t_m+dt_m) m? Mount hole xy projected
area

By default, the mesh is fixed in all domains. Remove this constraint for the mount and

plates by adding a Free Deformation node:

DEFORMED GEOMETRY (DG)

Free Deformation |
I In the Model Builder window, under Component | (compl) right-click

Deformed Geometry (dg) and choose Free Deformation.

2 In the Settings window for Free Deformation, locate the Domain Selection section.
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3 From the Selection list, choosc Deformed mesh domains.

The virtual boundary displacements must be described in a boundary system which does

not rotate with the deformation.

DEFINITIONS

Boundary System | (sysl)
I In the Model Builder window, under Component | (compl)>Definitions click

Boundary System 1 (sysl).
2 In the Settings window for Boundary System, locate the Settings section.

3 From the Frame list, choose Geometry configuration.

DEFORMED GEOMETRY (DG)

Prescribed Mesh Displacement |
I In the Model Builder window, under Component | (compl)>Deformed Geometry (dg) click

Prescribed Mesh Displacement |I.

2 In the Settings window for Prescribed Mesh Displacement, locate the

Coordinate System Selection scction.
3 From the Coordinate system list, choose Boundary System | (sysl).

4 Locate the Prescribed Mesh Displacement scction. Clear the Prescribed t1 displacement

check box.

5 Clear the Prescribed t2 displacement check box.
This default condition will apply to the boundaries where you do not prescribe nonzero
displacements.

Prescribed Mesh Displacement 2

I In the Physics toolbar, click mw Boundaries and choose Prescribed Mesh Displacement.

2 In the Settings window for Prescribed Mesh Displacement, locate the Boundary Selection

section.
3 From the Selection list, choose Outer mount faces.

4 Locate the Coordinate System Selection section. From the Coordinate system list, choose

Boundary System 1 (sysl).

5 Locate the Prescribed Mesh Displacement section. Clear the Prescribed t1 displacement

check box.

6 Clear the Prescribed t2 displacement check box.

Il | SENSITIVITY ANALYSIS OF A COMMUNICATION MAST DETAIL



7

In the d,, text field, type dt_m.

Prescribed Mesh Displacement 3

|
2

In the Physics toolbar, click mw Boundaries and choose Prescribed Mesh Displacement.

In the Settings window for Prescribed Mesh Displacement, locate the Boundary Selection

section.
From the Selection list, choose Plate surface.

Locate the Coordinate System Selection section. From the Coordinate system list, choose
Boundary System 1 (sysl).

Locate the Prescribed Mesh Displacement section. Clear the Prescribed tl displacement
check box.

Clear the Prescribed t2 displacement check box.

In the d,, text field, type dt_p.

STUDY 2

Now, set up the study. In particular, you need to add a Sensitivity node. But first, you must

enable advanced study options.

Click the ® Show More Options button in the Model Builder toolbar.

2 In the Show More Options dialog box, in the tree, select the check box for the node
Study>Sensitivity.

3 Click OK.

Sensitivity

I In the Study toolbar, click Illln Sensitivity.
By using the forward method, you will have access to the derivatives of the solution with
respect to the sensitivity variables dm_p and dm_m.

2 In the Settings window for Sensitivity, locate the Sensitivity Method section.

3 From the Gradient method list, choose Forward.
The stiffness ratio computed in the original model serves as the objective function.

4 Click Replace Expression in the upper-right corner of the Objective Function section.
From the menu, choose Component | (comp1)>Definitions>Variables>compl.S_R -
Stiffness ratio.

5 Locate the Control Variables and Parameters scction. Click — Add.

6 Click | Add.
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7 In the table, enter the following settings:

Parameter name Value Scale Value type
dm_p (Added mass, plate) 0 1 Real
dm_m (Added mass, mount) 0 1 Real

8 In the Study toolbar, click = Compute.

RESULTS

Begin by evaluating the sensitivities of the stiffness ratio with respect to the two types of

small additions.

Global Evaluation 3

I In the Results toolbar, click (5 Global Evaluation.

2 In the Settings window for Global Evaluation, locate the Data section.
3 From the Dataset list, choose Study 2/Solution 5 (sol5).

4 Locate the Expressions section. In the table, enter the following settings:

Expression Unit Description

fsens(dm_m)

5 Click = Evaluate.

Global Evaluation 4

I Right-click Global Evaluation 3 and choose Duplicate.

2 In the Settings window for Global Evaluation, locate the Expressions section.

3 In the table, enter the following settings:

Expression Unit Description

fsens (dm_p)

4 Click the arrow next to the Evaluate button and choose Table 3 - Global Evaluation 3
(fsens(dm_m)).

Create a plot for the sensitivity of axial displacement with respect to change in the added

plate mass.

Sensitivity
I In the Results toolbar, click .‘i 3D Plot Group.

2 In the Settings window for 3D Plot Group, type Sensitivity in the Label text field.
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3 Locate the Data section. From the Dataset list, choose Study 2/Solution 5 (sol5).
Surface |
I Right-click Sensitivity and choose Surface.

In the Settings window for Surface, locate the Expression section.

In the Expression text field, type sens(w,dm_p).

2

3

4 Locate the Coloring and Style section. Click : | | Change Color Table.

5 In the Color Table dialog box, sclect Thermal>ThermalDark in the tree.
6

Click OK.
Surface |
I In the Model Builder window, click Surface 1.
2 In the Sensitivity toolbar, click Plot.
Deformation |
I Right-click Surface | and choose Deformation.
2 In the Settings window for Deformation, locate the Expression section.
3 In the X-component text field, type u+1[mm]*mA_pl*sens(u,dm_p).
4 In the Y-component text field, type v+1[mm]*mA_pl*sens(v,dm_p).
5 In the Z-component text field, type w+1[mm]*mA_pl*sens(w,dm_p).

These deformations give a linear approximation of the deformation that would result

from a 1 mm increase in the plate thickness.
6 In the Sensitivity toolbar, click Plot.
Sensitivity
I In the Model Builder window, under Results click Sensitivity.
2 In the Settings window for 3D Plot Group, click to expand the Title section.
3 From the Title type list, choosc Manual.
4 In the Title text area, type Surface: Sensitivity of w to added plate mass.

5 In the Sensitivity toolbar, click Plot.
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